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Warranties and Liabilities 

 

The information and the software discussed in this document are subject to change without 
notice and should not be considered commitments by Ticodi Limited.  Ticodi Limited assumes 

no responsibility for any errors in this document. 

 

The software discussed in this document is furnished under a license and may be used or 

copied only in accordance with the terms or the license.  No responsibility is assumed by 
Ticodi Limited for the use or reliability of software on equipment that is not supplied by Ticodi 

Limited or its affiliated companies. 

 

All warranties given by Ticodi Limited about equipment or software are set forth in your 

purchase contract, and nothing stated in, or implied by, this document or its content shall be 
considered or deemed a modification or amendment of such warranties. 

 

Copyright 

 

© Copyright 2009 - 2010 Ticodi Limited 

 

Ticodi Limited, including this documentation, and any software and audiovisual displays 

described therein; all rights reserved; may only be used pursuant to the applicable software 
license agreement; contains confidential and proprietary information of Ticodi and/or other 

third parties which is protected by copyright, and may not be provided or otherwise made 
available without prior written authorisation. 
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1 Read This First 
 

1.1 The Scope of this Guide 

 

This manual introduces the facilities provided by ModelInsight.  It explains the main concepts 
of ModelInsight and shows how you can apply these to your own projects. 

 

The chapters of this guide take the form of a hands-on tutorial combined with frequent 
explanation of the underlying concepts.  As you work progressively through the exercise, you 

will gain practical experience of the ways in which you can use ModelInsight while learning 

about the powerful facilities it provides. 

 

This guide has been written for users that are familiar with model review practices. 

 

1.2 Text Conventions 

 

This guide uses the following text conventions: 

 

Tahoma  for the majority of the text. 

 

Bold  to highlight important information, and to introduce special terminology. 

 

Tahoma italic for form names. 

 

1.3 Terminology 

 

You can switch rapidly between different parts of the program, so that distinctions between 
them become almost imperceptible, but you need to recognize what is happening when you 

select from the different functions available to you from the various menus. 

 

The following terms are used throughout this guide to describe what action to carry out: 

 

Enter Type text into the specific dialogue box, then press the Enter or Return key 
to confirm the entry. 

 

Click Click on the required item to select it. 

 

Double Click Place the mouse pointer over specified point, then click the left-hand mouse 

button twice in quick succession. 
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2 Using Forms 

 
Forms can include any of the following controls: 

 

• Text boxes 

 

• Drop-down lists 

 

• Option buttons 

 

• Check boxes 

 

• Scrollable lists 

 

• Action buttons 

 

• Slide bars 

 

2.1 Using Text Boxes 

 

Text boxes are the area where you type in alphanumeric data.  A text box will usually have a 
label associated with it to tell you what to enter. 

 

When you first open a form which contains text boxes, the first text box on the form is 
usually current and a text editing pointer (a vertical bar) is displayed in the box. 

 

To enter data within a text box, follow the procedure below: 

 

• Click in the text box to display the text editing pointer. 

 

• Type in the required data. 

 

2.2 Using Drop-down Lists 

 

Drop-down lists let you choose one option from a multiple selection.  The list will usually have 
a label to tell you what you are selecting and will show the current selection. 

 

A typical drop-down is shown below: 

 

 
 

To change the selection, click the ‘down’ arrow or button-face to reveal the full list of 

available options; then pick the required option. 

 

2.3 Using Option Buttons 

 

Option buttons are used to select one, and only one choice, from a group of options.  The 

selection is mutually exclusive, so that selecting one option deselects others in that group. 

 

A typical option button is shown below: 

 

 Option selected. 

 

 Option not selected. 

 

2.4 Using Check Boxes 
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Check boxes are used to switch an option between two states, typically set and unset.  Unlike 
option buttons, they are not linked, so that you can set any combination of check boxes at 

the same time. 

 

A typical check box is shown below: 

 

 Set 

 

 Unset 

 

2.5 Using Scrollable Lists 

 

A scrollable list is displayed as a vertical list of options within the form, with vertical and 
horizontal scroll bars along its sides.  To select an option, click on the line you want.  The 

selected line is then highlighted. 

 

2.6 Using Action Buttons 

 

Most forms include one or more action buttons.  You use these to tell ModelInsight when to 

action a form. 

 

The common action buttons are shown below: 

 

 Tells ModelInsight to accept the current form settings and closes the form. 

 

 Cancels any changes you have made to the form, and closes the form. 

 

 Reset form back to original state. 

 

Some forms contain more specific types of control buttons which carry out particular 
command options.  The action is indicated by the name of the button e.g. Save, Remove, Add 

etc. 

 

2.7 Using Action Buttons 

 

Most forms include one or more action buttons.  You use these to tell ModelInsight when to 

action a form. 

 

2.8 Using Slide Bars 

 

A slide bar can be displayed as either a vertical or horizontal control.  The slide bar allows you 
to change a value using a sliding control. 

 

A typical slide bar is shown below: 

 

 
 

2.9 Responding to Message Forms 

 

Message forms are used to display information such as Error, Warning and Information 
messages, as well as prompts and requests for confirmation of changes.  You should respond 

by carrying out the prompted task, or by clicking on the control buttons on the form e.g. OK, 

Yes, No or Cancel. 
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3 Introducing ModelInsight 

 
3.1 Starting ModelInsight 

 

Start ModelInsight by selecting Start>All 
Programs\Ticodi\ModelInsight\ModelInsight  

 

3.2 The Main ModelInsight Window 

 

The ModelInsight window and a number of docking panels are displayed as standard, as 

shown below: 

 

3.3 The Toolbars 

 
You can change your ModelInsight toolbars by selecting the relevant toolbar tabs, as shown 

below: 

 

 
 

Explained below are the toolbars for each of the relevant toolbar tabs. 

 

3.3.1 Navigation Control Toolbar 

 
Select the Main toolbar tab to display the Navigation toolbar: 

 

 
 

The functions of each of the buttons are explained in detail below: 

 

 

Default Navigation Mode This mode allows the use of both keyboard and 

mouse functions.  This allows the ability to zoom, 
pan and rotate all at the same time. 

   

 

Zoom Dolly This mode uses the mouse to zoom in and out of 
the model. 

   

 

Rotate Target This mode uses the mouse to rotate the model 

about the point that the model is being observed 
from (the user position). 

   

 

Rotate Camera This mode uses the mouse to rotate the 
observation point (the user position) about the 

model. 

   

 

Pan This mode uses the mouse to pan the model left, 

right, up and down. 
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Walk This mode uses the mouse to walk through the 
model on a horizontal plane. 

   

 

Fit Zooms out automatically to ensure that the 
whole extent of the model is visible in the view 

window. 

 

3.3.2 Detail Control Toolbar 

 
Select the Main toolbar tab to display the Detail Control toolbar: 

 

 

 
The Detail Control toolbar is used to control the level of detail of the model that is displayed 

within the view window.  This functionality provides the ability to increase the response time 

of the model whilst be manipulated as it reduces the rendering time.  When you zoom in on 
the model the level of detail will increase to ensure that you are able to see all model detail 

but only within your direct line of sight. 

 

 

Max Detail This button increases the model 
detail to maximum in one easy 

step. 

   

 
Detail Level This slide bar allows you to increase 

or decrease the model detail level.  

 

3.3.3 Tool Toolbar 

 
Select the Tools toolbar tab to display the Tool toolbar: 

 

 
 

 

Select This mode allows the selection of an element 
from the model. 

   

 

Measure This places ModelInsight in dimension mode. The 
Dimension toolbar will be display, refer to 

section 3.3.4 
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3.3.4 Measure Toolbar 

 
Shown below is the Measure toolbar that is displayed when the Measure button is selected: 

 

 
 

 

Area Calculates an area on a plane. 

   

 

Polyline Measures a total distance between multiple 
points along a route. 

   

 

Single Measures the distance between two points. 

   

 

Persist Displays multiple measurements on screen 
even when model manipulation occurs. 

   

 

Clear All  Clears the view of all measurement lines and 
test. 

   

 

Snap Modes Corner – Snaps to an intersect point. 

Middle – Snaps to mid point. 

Near – Snaps to a point on a surface. 

Center – Snaps to the centre point of an object. 

   

3.3.5 Tool Toolbar 

 
Select the Rendering toolbar tab to display the Render Quality toolbar: 

 

 

 

 

Minimum Render Switches off advanced rendering 
and lighting. 

   

 
Render Level Adjusts level of advanced rendering 

and lighting. 

 

Maximum Render Turns advanced rendering and light 
to maximum. This button applies 

maximum advanced rendering. The 
Daylight Factor toolbar will be 

display, refer to section 3.3.6 
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3.3.6 Daylight Factor Toolbar 

 
Shown below is the Daylight Factor toolbar that is displayed when the Maximum Render 
button is selected: 

 

 

 

 Time Slider This slider bar allows you to 
increase or decrease the time of 
day, therefore affecting the amount 

of light. 

   

 
Sun Intensity This slide bar allows you to 

increase or decrease the intensity 

of the sun.  

 

 

3.3.7 Display Toolbar 

 
Select the Display toolbar tab to display the Video toolbar: 

 

 

 

 

Split Screen Arranges the layout of ModelInsight forms over 

a dual screen display. 

   

 

Background Colour Changes the background colour of the 3D view 
window. 

   

 

Depth Cue Draws the model with a transparency effect, 

the nearer the subject the more opaque the 
model elements are rendered, the further away 

the subject the more transparent the model 
elements become. This technique can serve as 

an aid to determine what is closest and 

furthest from the camera. 

 

3.3.8 Display Format Toolbar 

 

Select the Display toolbar tab to display the Display Format toolbar: 
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Cascade Windows Displays model windows in cascade layout 

   

 

Tile Windows Vertically Displays model windows in tile vertically layout 

   

 

Tile Windows Horizontally Displays model windows in horizontal layout 

   

 

1/3 Window Layout Displays model windows in 1/3 vertical layout 

   

 

1/4 Window Layout  Displays model windows in 1/4 vertical layout 

   

 

2 by 2 Window Layout Displays model windows in 2 by 2 layout 

   

 

Maximize Window Maximize model window 

   

 

Minimize Window Minimize model window 

 

3.3.9 Image Snapshot Toolbar 

 

Select the Capture toolbar tab to display the Image Snapshot toolbar: 

 

 
 

 

Save Image Captures screen shot of model 
window at selected image size 

and resolution 

   

 
Image Size Defines the image size of the 

screen shot: 

 

A0 – 841x1189mm, 33.1x46.8in 

A1 – 594x841mm, 23.4x33.1in 

A2 – 420x594mm, 16.5x23.4in 

A3 – 297x420mm, 11.7x16.5in 

A4 – 210x297mm, 8.3x11.7in 

A5 – 148x210mm, 5.8x8.3in 
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A6 – 105x148mm, 4.1x5.8in 

A7 – 74x165mm, 2.9x4.1in 

A8 – 52x74mm, 2.0x2.9in 

A9 – 37x52mm, 1.5x2.0in 

A10 – 26x37mm, 1.0x1.5in 

   

 
Image Resolution Defines the image resolution of 

the screen shot: 

 

60 DPI (CRT Display) 

75 DPI (CRT Display) 

96 DPI (Flat Panel) 

120 DPI (Flat Panel) 

150 DPI (Cell Phone) 

200 DPI (Inkjet) 

300 DPI (Laser / Inkjet) 

600 DPI (Hi-Res Inkjet) 

   

 Swap Safe Frame Swap safe frame display to either 

display the image size in 
horizontal or vertical orientation 

 

3.3.10 Image Snapshot Toolbar 

 

Select the Capture toolbar tab to display the Image Snapshot Options toolbar: 

 

 

 

 

Display Safe Frame Displays safe frame which allows 
you to see the limit of your image 

size in the model window 

   

 

Save Options Allows you to specify the location 
and name of your screen capture 

image file. 
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4 Load a Model File for Viewing 
 

ModelInsight is able to open Microstation 3D model files (.dgn, .prp, .ppg) and PDS Design 

Review File (.dri).   

 

The ModelInsight software includes a number of Microstation 3D model files and one PDS 

Design Review File, ModelInsight.dri which you may load in order to practice using 
ModelInsight. 

 

4.1 Loading a Model File Into ModelInsight 

 
To load or import a model file into ModelInsight this is done through the Open Model File 
form.  To display this form it can be done by one of the following methods:   

 

Select from the Main Menu the Open… button, as shown below: 

 

 
 

The Open Model File form will then be displayed, as shown below: 
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To select the model file to be loaded, select the Browse button, this will open the standard 
Windows Open dialog form and functions in the same way.  The following files types can be 

opened: 

 

  File Type Purpose 

PDS Design Review File (.dri) A design review file that holds references 
back to a number of Microstation 3D design 
files, this allows all files to be loaded in one 

step. 

Microstation 3D Design File (.dgn, .prp, .ppg) A 3D Microstation design file. 

 

Select the relevant settings to load the model file with: 

 

Setting Option Description 

Economy Level Economy Level is a feature to allows ModelInsight to load models 

greater than the available memory by dynamically loading components 
of the model based on visibility and range (distance from viewer).  

Ticodi have successfully tested this feature to a ratio of 2 to 6. In 
other words a 6GB model can be loaded and dynamically loaded on 

the fly on a computer with only of 2Gig of RAM. 

 

Here are meanings of eco level settings : 

 

-1: Will statically load entire model. 

0: Will dynamically load/unload the tiniest portions of the model to a 

maximum size of a staircase runner or risers. 

1: Will dynamically load/unload small model elements. 

2: Will dynamically load/unload medium model elements. 

3: Will dynamically load/unload large model elements. 

 

Note: This feature also affects level of detail. 

Bspsize BSP meaning Block Space Partition. BSP is a method of dividing a 

models' space to speedup visibility and to better manage memory. 
When a models' size increases, usually but not always, the bspsize will 

decrease.  Here are acceptable bspsize settings to model size / file 
count. 

 

512  for  models < 500MB of data or approx < 500 files 

256  for  models  > 500MB  of data or approx > 500 files 

128  for models > 1GB of data or approx > 1000 files 

64   for models > 2GB of data or approx > 2000 files 

Not using the bspsize feature correctly will affect ModelInsight 

dramatically and could cause the application to fault. When uncertain 
what value to use it is always best to use 64.   

Note: The bspsize affects depthcue feature. 
Depthcue Draws the model with a transparency effect, the nearer the subject 

the more opaque the model elements are rendered, the further away 

the subject the more transparent the model elements become.  This 
technique can serve as an aid to determine what is closest and 

furthest from the camera. 

Note: This feature is affected by bspsize. The smaller bsp setting 

increases transparency. 
Fastblit This feature works directly with depthcue, rendering transparently is 

taxing on the video card, fastblit reduces the effect when enabled.  It 

is best to use fastblit with large models if you plan to view the model 
with depthcue enabled. 
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Select one of the three database options (only required if loading a .dri file) 

 

Database Option Description 

New Creates a new ModelInsight database. 

Reload Reloads an existing ModelInsight database.  This mode reloads model 

data from .drv files and synchronises display sets with model data.  
This mode ensures that any changes to the model since the database 

was originally created are captured. 

Existing Loads ModelInsight database in its current state, which no change to 

model data or display set synchronisation. 

 
Exercise:  Load the file ModelInsight.dri from your ModelInsight installation. 

 

 

4.2 The Model Tree 

 

 
 

The Model Tree provides a hierarchical view of the model files and elements loaded in 

ModelInsight.  Click the expansion box (  ) to expand the hierarchy (the box changes to  ); 

click the  to close up the hierarchy. 

 

4.2.1 Highlighting Elements in 3D View Window  

 

Selecting an item from the Model Tree will highlight the relevant 3D elements in a semi-
transparent colour.  This functionality is available if you select either the overall Microstation 

3D Model File or expand the Model File Node and select either Levels or individual design 
elements. 

 

To cancel this highlighting, right mouse click in the 3D View Window. 

 

4.2.2 Control Visibility of the Model 

 

You can control which parts of the complete design model are to be included (visible) or not 
included (invisible) in the graphical display. 

 

To make elements invisible, carry out the following steps: 

 

Select the  button to the left hand side of the element that you wish to make invisible from 

the Model Tree. 
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The element will then be made invisible and the  button will change to , this indicates 
that the element is invisible. 

 

To make elements visible, carry out the following steps: 

 

Select the  button to the left hand side of the element that you wish to make visible from 

the Model Tree. 

The element will then be made visible and the  button will change to , this indicates that 

the element is visible. 

 

This functionality is available on all model file elements by expanding the model file hierarchy 

(see section 4.2) 
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5 Navigating 

 
ModelInsight enables intuitive and interactive navigation around your 3D models.  The six 

navigation modes give you complete flexibility to navigate around the model in real time.  In 
addition to these navigation modes, there are selection tools that further facilitate the 

interrogation of the model data. 

 

The tilt and rotate bars on the Plan View enables you to tilt or rotate the camera.  The 
thumbnail Plan View also give you a good overall view of the scene, allowing you to see 

whereabouts you are in the whole model and quickly jump to other areas of the model by 
reposition the camera in the Plan View. 

 

5.1 Common Mouse Operations 

 

 

(Click) The view centers on the object under the pointer and the object origin 
is used as the camera rotation or focus point.  Information about the selected 
object is displayed within the Information view. 

 

(Click) The current object selection is cancelled. 

 

5.2 Default Navigation Mode 

 

 

Default Navigation Mode is a mixed mode of keyboard and mouse navigation, 
including mouse selection ability. 

 

5.2.1 Default Navigation Mode – Keyboard Operations 

 

Key Navigation Action 

W Zooms in  

S Zooms out 

A Pan left 

D Pan right 

Space Bar Toggles between Rotate Camera and Rotate Target modes. 

 

5.2.2 Default Navigation Mode – Mouse Operations 

 

 

(Drag) Rotate the observation point (the user position) about the model.  
This is in both vertical and horizontal planes. 

 

5.3 Zoom Dolly Mode 

 

 

Zoom Dolly Mode is a mouse zoom in and out mode only, including mouse 
selection ability. 

 

5.3.1 Zoom Dolly Mode – Mouse Operations 
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(Drag) Move mouse pointer up the screen moves the camera further away 
from the model (zooms out).  The amount the camera position moves is 
proportional to the distance moved by the mouse from the button-down 
pressing position during the drag. 

 

(Drag) Move mouse pointer down the screen moves the camera closer to the 
selected object (zooms in).  The amount the target position moves is 

proportional to the distance moved by the mouse from the button-down 
pressing position during the drag. 

 
5.4 Rotate Target Mode 

 

 

Rotate Target Mode is a mouse mode only to rotate the model about the point that 

the model is being observed from (the user position). 

 

5.4.1 Rotate Target Mode – Mouse Operations 

 

 

(Drag) The model target position moves in the direction of the mouse 

pointer movement, the camera view changes accordingly.  The amount the 
target position moves is proportional to the distance moved by the mouse 

from the button-down pressing position during the drag. 

 

5.5 Rotate Camera Mode 

 

 

Rotate Camera Mode is a mouse mode only to rotate the observation point (the 

user/camera position) about the model. 

 

5.5.1 Rotate Camera Mode – Mouse Operations 

 

 

(Drag) The camera position moves in the direction of the mouse pointer 

movement, the camera view changes accordingly.  The amount the camera 
moves is proportional to the distance moved by the mouse from the button-
down pressing position during the drag. 

 

5.6 Pan Mode 

 

 

Pan Mode is a mouse mode only to pan the camera postion. 

 

5.6.1 Pan Mode – Mouse Operations 

 

 

(Drag) The camera position pans in the direction of the mouse pointer 

movement, the camera view changes accordingly.  The amount the camera 
panned is proportional to the distance moved by the mouse from the button-
down pressing position during the drag. 
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5.7 Walk Camera Mode 

 

 

Walk Camera Mode is a mouse mode only walk through the model on a horizontal 
plane. 

 

5.7.1 Walk Camera Mode – Mouse Operations 

 

 

(Drag) The camera position pans in the direction of the mouse pointer 
movement, the camera view changes accordingly.  The amount the camera 

panned is proportional to the distance moved by the mouse from the button-
down pressing position during the drag. 

 

5.8 Plan View Window 

 

The Plan View window displays a rendered plan view of the entire model.  The Plan View 

window is useful to get an overall view of where you are in the entire model and to quickly 
move the camera to a location in a model.  The Plan View displays a line marker which 

represents your current viewpoint.  The market moves as you navigate through the model, 
showing your location and your view direction. 

 

 
 

5.8.1 Plan View Navigation Mode – Keyboard Operations 

 

Key Navigation Action 

W Zooms in  

S Zooms out 

A Pan left 

D Pan right 

 

5.8.2 Plan View Navigation Mode – Mouse Operations 

 

 

(Drag) The Plan View thumbnail pans in the direction of the mouse pointer 

movement.   

  



 21 

6 Measuring 

 
Measuring allows you to measure between points on items in the model. All measurements 

are made in Meters (M). 

 

Measuring mode is mutually exclusive to the navigation modes so that when you are 

measuring, you cannot navigate the model. 

 

The measure tools, which can all be accessed from the Tools tab by selecting the measure 
button. 

 

6.1 Measure Modes 

 

6.1.1 Area 

 

 

1. Ensure Measure Mode is activated as outlined in section 3.3.3. 

2. Select the Area measure button. 

3. Identify an item in the model you wish to measure, the item will be 
highlighted as semi-translucent. 

4. Hover your mouse cursor over the item, measure snap points will be 
displayed depending on your snap settings. 

5. Simply click on a series of points to specify the perimeter of the area you 

wish to calculate. 

6. To complete the area measurement command your last click must be your 

area measure start point (your first click), this allows the closure of the 
area perimeter plane. 

 

6.1.2 Polyline  

 

 

1. Ensure Measure Mode is activated as outlined in section 3.3.3. 

2. Select the Polyline measure button. 

3. Identify an item in the model you wish to measure, the item will be 

highlighted as semi-translucent. Hover your mouse cursor over the item, 
measure snap points will be displayed depending on your snap settings. 

4. Simply click on a series of points to specify the polyline to be calculated. 

5. To complete the polyline measurement command identify your last point 

twice. 

  

Note: If you wish to measure / snap between more than one model item, simply select the 
new model item. This item will then be highlighted semi-translucent and will allow measure 

snap points to be selected. 

 

6.1.3 Single – Point to Point 

 

 

1. Ensure Measure Mode is activated as outlined in section 3.3.3. 

2. Select the Single measure button. 

3. Identify an item in the model you wish to measure, the item will be 

highlighted as semi-translucent. Hover your mouse cursor over the item, 
measure snap points will be displayed depending on your snap settings. 

4. Simply click your start point and end point to be calculated. 

  

Note: If you wish to measure / snap between more than one model item, simply select the 
new model item. This item will then be highlighted semi-translucent and will allow measure 

snap points to be selected. 
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6.1.4 Persist 

 

 

Persist mode displays multiple measurements on the screen even when model 
manipulation occurs.  If Persist mode is turned off only the last measurement 

performed will be displayed, and if the model view changes the measurement will 

be removed from your view. 

 

6.1.5 Clear All 

 

 

This clears the view of all measurement lines and restarts the measurement. 

 

6.2 Snapping 

 

There are various snapping modes that allow you to set the cursor to snap to the nearest 

vertex, nearest point and middle of a line.  Points and snap points are automatically snapped 
to.  Different colour snap nodes define what is being snapped to: 

 

 
Corner Snapped to nearest vertex. 

 
Middle  Snapped to middle of a line. 

 
Near Snapped nearest point. 

 
Complete Command Snapped and if selected completes 

measurement command. 
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7 Search 

 
In ModelInsight, searching the model for items based on their properties is quick and simple 

using the Search facility.  The Search form is always docked on the right of ModelInsight, 
simply expand the docking form to display the Search form, as shown below: 

 

 
 

7.1 Searching Items Based on Properties 

 

The Search Criteria contains three dropdown boxes, Property, Condition and Value.  This is 

where the search criteria are set-up.  Using the dropdown boxes, you define a search 
condition that is used to search the model. 

 

1. Select the Property you wish to search the model for.  The Property dropdown lists 
all the model element properties found within your loaded model e.g. equipment 

numbers, line numbers etc. 

2. From the Condition dropdown list, choose the condition you wish to test for.  This 

will depend on the type of property you are searching for.  For example:  

 

Condition Description 

Equal Returns results with the chosen Property that match the entered Value. 

Not Equal Returns results with the chosen Property except the element matching 
the entered Value. 

Contains Returns results that match a series of characters that are entered in the 

Value field. 

Wildcards Returns results that match the wildcard statement in the Value field.  A 
wildcard statement can be any characters or an arbitrary sequence of 

characters. 

Does Not Contain Returns results that do not match the series of characters that are 

entered in the Value field. 

Not Wildcards Returns results that do not match the wildcard statement in the Value 
field. 
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3. To enter a value in the Value dropdown, you can either type in a value freely in the 
text box, or choose a pre-defined value from the dropdown list which shows all 

values in the model available that match your selected Property. 

4. Select the  button to start your search. 

5. Once the search is complete the search results will be displayed in the Search Results 
table. 

6. Selecting an item from the Search Results table automatically highlights the element 

in your view and makes the element the centre focus point of the camera.  To focus 

on the element simply use standard navigation modes to zoom to the item. 
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8 Taking a Snapshot                                                                

 
The snapshot command allows you to create an image file by outputting a snapshot of the 

current model view content.  The image file is saved as a .tga (Targa) format as this gives a 
high-end image file. 

 

To create a snapshot: 

 

1. Select the Render toolbar tab to display the Image Snapshot toolbar, as shown 
below: 

 

 
 

2. Select the paper / image size required from the image size dropdown, there are 

various paper sizes available: 

 

Paper Size Dimensions (mm) Dimension (in) 

A0 841 x 1189mm 33.1 x 46.8in 

A1 594 x 841mm 23.4 x 33.1in 

A2 420 x 594mm 16.5 x 23.4in 

A3 297 x 420mm 11.7 x 16.5in 

A4 210 x 297mm 8.3 x 11.7in 

A5 148 x 210mm 5.8 x 8.3in 

A6 105 x 148mm 4.1 x 5.8in 

A7 74 x 165mm 2.9 x 4.1in 

A8 52 x 74mm 2.0 x 2.9in 

A9 37 x 52mm 1.5 x 2.0in 

A10 26 x 37mm 1.0 x 1.5in 

 

3. Select the image resolution required from the image resolution dropdown, there are 

various resolution options available: 

 

Resolution 

60 DPI (CRT Display) 150 DPI (Cell Phone) 

75 DPI (CRT Display) 200 DPI (Inkjet) 

96 DPI (Flat Panel) 300 DPI (Laser / Inkjet) 

120 DPI (Flat Panel) 600 DPI (Hi-Resolution Inkjet) 

 

4. Turn on Safe Frame option by clicking the  button.  This will display the 

paper / image size visually in the model window.  Use the  check box to 

orientate the safe frame margins.  Manipulate you model window to ensure that the 

required model content is within the safe frame boundaries. 

 

5. Click the  button, this will allow you to specify the location and file name 

of your screen capture file.   

 

Note: If you do not specify a location for the image file using the Save Options 
then the screen capture image file will be saved in the ModelInsight installation 
directory with a file name of MISCapImageFull.tga 
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6. Click the  button, this will start the screenshot process.  You will notice that 
the model window becomes blurred whilst the horizontal progress bar passed from 

left to right across the model window.  This displays the percentage complete of the 
image output process. 

 

Note:  ModelInsight MUST be the focused / active application whilst this process is 

working.  If another application becomes active (or is used) whilst this process is 
working then the screenshot output will not produce correct results. 

 

Note:  The image file will need to be vertically flipped to display correctly.  This is 
because a Targa files writes the content of the file in reverse, and due to the large 

amount of memory that is required to generate the image screenshot ModelInsight is 
unable to flip the image automatically without the possibility of using all your 

machine memory. 
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9 Display Set 

 
ModelInsight includes the ability to create a set of graphical objects that a colour 

change can be applied to, called display sets. Display sets can be used for performing 
regular actions e.g. changing the colour of all pipes with a certain pipe specification. 

 

Display sets are a group of objects that match search criteria that you define. Display 

sets can be re-run after creation, therefore if the model changes then the group of 
objects for a display set is recompiled thus ensuring that changes in model 

development is synchronised with display sets.  

 

Note 
Display sets are synchronised only when the Database Reload option is selected when 
loading a model, please refer to section 4. 
 

9.1 Creating a Display Set 

 

1. Select the  button from the Tool tab will display the Display Set docking 

form, as shown below.  Creation, editing and deleting display sets is all done using 
the Display Set docking form. 
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2. Select the Display Sets item from the ModelInsight Explorer tree.  

3. Select the  button 

 

or 

 

Right-click on the Display Sets item in the ModelInsight Explorer tree and click 
Display Set>New from the shortcut menu. 

 

4. The Create Display Set controls will become active and a display set search criteria 
control will be displayed, as shown below: 

 

 
 

5. Enter the name of the display set in the Display Set Name text field. 

6. Select the colour that you wish the model objects to be shown in from the Colour 
dropdown. 

7. Select the Property you wish to apply your display set to.  The Property dropdown 

lists all the model element properties found within your loaded model e.g. equipment 

numbers, line numbers etc. 

8. From the Condition dropdown list, choose the condition you wish to test for.   

 

Condition Description 

Equal Returns results with the chosen Property that match the entered Value. 

Not Equal Returns results with the chosen Property except the element matching 
the entered Value. 

Contains Returns results that match a series of characters that are entered in the 

Value field. 

Wildcards Returns results that match the wildcard statement in the Value field.  A 
wildcard statement can be any characters or an arbitrary sequence of 

characters. 

Does Not Contain Returns results that do not match the series of characters that are 

entered in the Value field. 
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Not Wildcards Returns results that do not match the wildcard statement in the Value 
field. 

9. To enter a value in the Value dropdown, you can either type in a value freely in the 

text box, or choose a pre-defined value from the dropdown list which shows all 
values in the model available that match your selected Property. 

 

Note 

You can create complex display set search criteria by using the  and  buttons to 

add and remove additional display set search criteria. 

 

10. Once you have completed your display set search criteria, click the  

button.  This will find every model object that matches your display set search criteria 

and will visually highlight the object(s) in your 3D view.  This allows you to visually 

confirm that your display set is giving you the correct results prior to saving.  If you 

wish to modify your display set you can do so and click the  button again 

will modify your 3D view selection. 

11. To save your display set and apply the change of colour to the model click the 

 button. 

 

9.2 Editing a Display Set 

 

1. Select the  button from the Tool tab will display the Display Set docking 

form.  Creation, editing and deleting display sets is all done using the Display Set 
docking form. 

2. Select the display set from the ModelInsight Explorer tree that you wish to 
modify. 

3. Select the  button 

 

or 

 

Right-click on the display set you wish to modify in the ModelInsight Explorer tree 

and click Display Set>Edit from the shortcut menu. 

4. The display set information will then be loaded and displayed as normal. You can 

modify your display set in the same manner as you created the display set, refer to 
section 9.1.  

 

9.3 Rename a Display Set 

 

1. Select the  button from the Tool tab will display the Display Set docking 

form.  Creation, editing and deleting display sets is all done using the Display Set 
docking form. 

2. Select the display set from the ModelInsight Explorer tree that you wish to 

rename. 

3. Select the  button 

 

or 

 

Right-click on the display set you wish to rename in the ModelInsight Explorer 

tree and click Display Set>Rename… from the shortcut menu. 

4. The Rename display set form will be displayed as shown below: 
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5. Enter the new name for the display set and click the  button. 

 

9.4 Delete a Display Set 

 

1. Select the  button from the Tool tab will display the Display Set docking 

form.  Creation, editing and deleting display sets is all done using the Display Set 
docking form. 

2. Select the display set from the ModelInsight Explorer tree that you wish to delete. 

3. Select the  button 

 

or 

 

Right-click on the display set you wish to delete in the ModelInsight Explorer tree 

and click Display Set>Delete from the shortcut menu. 

4. You will be asked to confirm the deletion of the display set, once confirmed the 

display set will be deleted.  
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10 Saved Views 

 
ModelInsight includes the ability to save and return to views of the model which are 

of importance. 
 

10.1 Creating a Saved View 

 

1. Select the  button from the Tool tab will display the Display Set docking 
form.  Creation, restoring, renaming and deleting saved views is all done using the 

Display Set docking form. 

2. Select the Saved Views item in the ModelInsight Explorer tree.  

3. Select the  button 

 

or 

 

Right-click on the Saved Views item in the ModelInsight Explorer tree and click 

View>New… from the shortcut menu. 

4. The Create Saved View form will be displayed, as shown below: 

 

 
 

5. Enter the name you wish to give to the saved view. 

6. Click the  button will save the view and you will see the saved view 

appear in the ModelInsight Explorer tree. 

 

10.2 Rename a Saved View 

 

1. Select the  button from the Tool tab will display the Display Set docking 
form.  Creation, restoring, renaming and deleting saved views is all done using the 

Display Set docking form. 

2. Select the saved view from the ModelInsight Explorer tree that you wish to 

rename. 

3. Select the  button 

 

or 

 

Right-click on the saved view you wish to rename in the ModelInsight Explorer 
tree and click View>Rename… from the shortcut menu. 

4. The Rename View form will be displayed as shown below: 
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5. Enter the new name for the saved view and click the  button.  

 

10.3 Deleting a Saved View 

 

1. Select the  button from the Tool tab will display the Display Set docking 

form.  Creation, restoring, renaming and deleting saved views is all done using the 
Display Set docking form. 

2. Select the saved view from the ModelInsight Explorer tree that you wish to delete. 

3. Select the  button 

 

or 

 

Right-click on the saved view you wish to rename in the ModelInsight Explorer 

tree and click View>Delete from the shortcut menu. 

5. You will be asked to confirm the deletion of the saved view, once confirmed the 

saved view will be deleted.  

 

10.4 Restoring a Saved View 

 

1. Select the  button from the Tool tab will display the Display Set docking 
form.  Creation, restoring, renaming and deleting saved views is all done using the 

Display Set docking form. 

2. Select the saved view from the ModelInsight Explorer tree that you wish to 

restore. 

3. Select the  button 

 

or 

 

Right-click on the saved view you wish to restore in the ModelInsight Explorer 
tree and click View>Restore View from the shortcut menu. 

4. The saved view will be restored and your 3D view window will change to reflect the 

saved view camera direction. 
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11 Managing Your ModelInsight Explorer 

 
ModelInsight includes the ability to create folders and sub-folders within the 

ModelInsight Explorer tree to allow the creation of display sets and saved views in 
a managed manner. 
 

11.1 Creating a Folder 

 

1. Select either the Display Sets, Saved Views or a folder from the ModelInsight 
Explorer tree. 

2. To create a folder select the  button 

 

or 

 

Right-click on the Display Sets, Saved Views or a folder in the ModelInsight 

Explorer tree and click Folder>New Folder… from the shortcut menu. 

3. The Create New Folder form will be displayed, as shown below: 

 

 
 

4. Enter the folder name and click the  button. 

 

11.2 Rename a Folder 

 

1. Select the folder from the ModelInsight Explorer tree that you wish to rename. 

2. To rename a folder select the  button 

 

or 

 

Right-click on the folder you wish to rename in the ModelInsight Explorer tree and 

click Folder>Rename Folder… from the shortcut menu. 

3. The Rename Folder form will be displayed, as shown below: 

 

 
 

4. Enter the new folder name and click the  button. 

 

11.3 Delete a Folder 

 

1. Select the folder from the ModelInsight Explorer tree that you wish to delete. 

2. To delete a folder select the  button 

 

or 
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Right-click on the folder you wish to delete in the ModelInsight Explorer tree and 
click Folder>Delete from the shortcut menu. 

 

3. You will be asked to confirm the deletion of the folder, once confirmed the folder 

view will be deleted.  

 

Note: 

Deleting a folder will delete all sub-folders, saved views and display sets created 

under the folder level. 
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12 Loading Multiple Models 

 
ModelInsight allows the loading of multiple individual model files or DRI files within the same 

ModelInsight session.  There are two modes of loading multiple model files, merged or non-
merged mode, these modes are explained below. 

 

You can load additional model file(s), or DRI files in the normal manner (refer to section 4), 

however you will be prompted with the below prompt to select your loading mode. 

 

 
 

Once you have selected your loading mode the additional model(s), or DRI file will load and 

be displayed as normal. 

 

12.1 Merged Mode 

 

Merge individual model files, or DRI files into the primary model window (the default open 
view), once merge is initiated this becomes default behaviour for all other imported models. 

It can only be undone by either closing all models or closing the models that were merged. 

 

When more than one model view(s) are created, hovering over the individual views with the 

mouse will automatically load the contents of that view in the Plan View window. 

 

A maximum of 8 merged views are allowed. 

 

Note: This feature is affected by the amount of RAM available on the computers' video card. 
If 128 Meg is available only two (full) views can be created in dual screen mode, or four in 

single screen mode. (This feature is also affected by video resolution and the use of dual-

screen features at the OS level). 

 

12.1.1 Camera Matching 

 

Camera matching in merged mode, changing the orientation of any model view window will 
automatically change the view orientation of all the other open view windows to match the 

view being manipulated. 

 

12.2 Non-Merged Mode 

 

Non-Merge mode allows individual model files, or DRI files to be loaded into separate model 
view windows, once non-merge mode is initiated this becomes default behaviour for all other 

imported models. It can only be undone by either closing all models or closing the models 

that were merged. 

 

When more than one model view(s) are created, hovering over the individual views with the 

mouse will automatically load the contents of that view in the Plan View window. 

 

A maximum of 8 non-merged views are allowed. 

 

Note: This feature is affected by the amount of RAM available on the computers' video card. 
If 128 Meg is available only two (full) views can be created in dual screen mode, or four in 

single screen mode. (This feature is also affected by video resolution and the use of dual-
screen features at the OS level). 
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12.2.1 Camera Matching 

 

Camera matching in non-merged mode, changing the orientation of any model view window 

will automatically change the view orientation of all the other open view windows to match 
the view being manipulated. 
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13 ReviewInsight 

 
Ticodi ReviewInsight is an advanced model comment system, which provides a complete 

comment management solution.  ReviewInsight allows complete traceability of your model 
comments, engineering and client approval and advanced reporting.   

 

ReviewInsight is fully integrated into ModelInsight and provides you with a completely 

bespoke model commenting solution.  Using ModelInsight with ReviewInsight not only gives 
you all the standard functionality of ReviewInsight, but provides extra functionality: 

 

1) Saves camera position of your comment therefore allowing quick navigation back to 
the comment 

2) Saves clipped 3D volume of the model within ReviewInsight allowing users of 
ReviewInsight to view the clipped 3D volume of the model within ReviewInsight built 

in 3D viewing tool independently of any native model files. 

3) Automatically captures screen capture of model. 

4) Displays ReviewInsight comments within ModelInsight providing a single application 

session instead of having both ModelInsight and ReviewInsight open. 

 

Note:  For more detailed explanation of functionality please refer to the ReviewInsight User    

Guide which comes supplied with your ReviewInsight installation. 

 

13.1 Login to ReviewInsight 

 

If ReviewInsight is installed on your machine the ReviewInsight toolbar will be displayed 
under the Tools tab, as shown below: 

 

 
 

1. Select the  button, this will display the ReviewInsight Login form as shown 

below: 

 

 
 

2. Select your ReviewInsight project you wish to login to from the Select Project list. 
3. Enter your ReviewInsight Username and Password in the relevant text boxes. 

4. Click the  button to login. 
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5. If you successfully login to ReviewInsight then the Create Comment, View 
Comments and Log Out buttons on the ReviewInsight toolbar will become 

activate, as shown below: 

 

 
 

13.2 Create Comment 

 

1. Click the  button to display the ReviewInsight – Add Comment 

docking form, as shown below:  

 

 

 

2. Select the 3D element from within ModelInsight 3D view that you wish to store the 

comment against. 
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3. Enter the following information: 

 

Status (Required):  The ‘Status’ drop-down displays your project stages 
for your reviews e.g. 30%, 60%, General Comments 

etc. 

Objective (Required):  The ‘Objective’ drop-down displays your project 
objectives for the comments; this is a way of 

categorising your comments by an objective e.g. to 
review accessibility, safety, operability etc. 

Tag Name:  Enter the item name e.g. pump name, pipe name 
etc. 

Title:      The title given to the comment. 

Reference:  This can be used for CAD items if the CAD software 
allocates a unique reference number or name. This 

then makes it easy for the designer to navigate to 
the item within the CAD software. 

Discipline to Resolve: The engineering discipline that will resolve the 

comment. 

Type:      The type of comment recorded. 

Work Share Location: The workshare office location responsible for 
resolving the comment. 

Deadline Date:    A date when the comment should be cleared by. 

Construction Area:  The project construction area that the comment is 

in. 

Originators Name:    The name of the person who raised the comment. 

Comment Visibility Options:   To You Only 

The comment is only visible to the user who created 
the comment. 

To All Users Excl. Clients 

The comment is visible to all users except Clients. 
This allows you to restrict visibility of general day-

today comments that you do not wish Clients to see. 

To All Users Incl. Clients 

The comment is visible to all users including clients. 

Description:     A description of the comment. 

Suggested Action:  Suggested course of action that the designer/user 

should take to resolve the comment. 

 

4. Click the  button to save the model comment to ReviewInsight. 

5. You will be prompted if you wish to save 3D data, as shown below: 
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If you select ‘Yes’ to the prompt then a clipped 3D volume of model data will be 
saved to ReviewInsight allowing the 3D volume of the comment to be viewed by 

users of ReviewInsight using our built in 3D viewer without the need for the original 
native files. 

 

13.3 View Comments 

 

1. Click the  button to display the ReviewInsight – View Comments 

docking form, as shown below:  

 

 

 

2. Selecting a comment from the ReviewInsight – View Comments form will display 

the ReviewInsight – Comment Info form, as shown below.  The ReviewInsight 
– Comment Info form displays information about the comment, including a 

thumbnail image, description, proposed action and action taken of the comment. 
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13.4 Enter Action Taken 

 

The ‘Action Taken’ area on the ReviewInsight – Comment Info form is used to enter the 

action that has been taken to resolve the comment. 
 

To add an Action Taken against a comment: 

 
1. Enter the action taken description in the ‘Action Taken’ area on the ReviewInsight 

– Comment Info form. 

2. Click the  button on the ‘Action Taken’ area to accept the Action Taken description. 
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Once an action taken description has been entered the users name and date of when the 
action was entered is recorded and displayed in the Action Taken area.  You are able to enter 

more than one action taken description within this area, as shown below: 
 

 
 

3. A prompt will then be displayed asking if you wish to “Change comment work status 

to resolved” 
 

 
 

4. A prompt will then be displayed asking if you wish to “Add approval image for 

engineer to review” this allows the user to save an approval image of the comment 

for the Engineers to review prior to Engineer Approval. 
 

 
 

13.5 Approve a Comment 

 

The approval option in ReviewInsight allows comments to be approved by both a selected 
project user(s) (dependent on access rights to ReviewInsight) and the client.  By approving 

comments by both parties allows you to easily identify comments that are yet to be approved 
by either party, therefore giving you complete traceability of comments. 

 

Note:   An Action Taken must be entered for a comment (refer to section 13.4) before a 
selected project user(s) can approve the comment. 

 
To approve a comment: 
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1. Select the comment from the comments list on the ReviewInsight – View 
Comments form. 

2. Click the  button on the ReviewInsight – View Comments form. 
 

3. You will then be prompted to acknowledge that you want to approve the comment, 
click the ‘Yes’ button on the prompt. 

 

4. A prompt will be displayed asking if you want to release the comment to client 
approval, as shown below: 

 

 
 

Yes This releases the comment for client approval and therefore makes 
the comment visible to ReviewInsight users with client logins. 

 

No Does not release comment for Client approval, and therefore these 
comments are not visible to ReviewInsight users with client logins. 

 
5. Your comment has now been approved. 

 

Note: The option to approve comments is dependent on ReviewInsight user access. 
 

13.6 Unapprove a Comment 

 
To unapprove a comment. 

 
1. Select the comment from the comments list on the ReviewInsight – View 

Comments form. 

2. Click the  button on the ReviewInsight – View Comments form. 

3. Your comment has been unapproved. 
 

Note: If a comment is unapproved by a selected project user, this will remove both their 
approval and the clients approval.  However if a comment is unapproved by a client 

user, this will only remove the client approval. 

 
 Both approval image and 3D data will be deleted when unapproving a comment. 

 

13.7 Navigate Camera to Comment 

 

To modify your 3D view to match the comment view. 
 

1. Select the comment from the comments list on the ReviewInsight – View 

Comments form. 

2. Click the  button on the ReviewInsight – View Comments form. 
3. Your 3D view will change to matched the comment saved camera position. 

 


